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Introduction

Here are some frequently asked questions about Makeblock robot kits which are based on mCore,
Orion, Auriga, and MegaPi boards, and the related PC software in this document is mBlock 3
(latest 3.4.12). If you haven’t downloaded the software, click here to download and install.
If you still have question after reading this document, please contact Makeblock Support Team at
support@makeblock.com.

http://www.mblock.cc/mblock-software/
mailto:support@makeblock.com
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Part I General Questions

How to connect Makeblock robot with mBlock

This article applies to: mBot, mBot Ranger, Starter, Ultimate, Ultimate 2.0

Devices required: PC (here we use windows); Makeblock robot kit (here we use mBot as an

example); USB cable

Step 1

Connect mBot to PC with USB cable and turn on the mBot.

Step 2

Open mBlock software, choosemBot(mCore) under Boards.

If you are using a starter, select Orion; for ultimate 2.0, select Megapi, etc.
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Step 3

Choose the correct Serial Port for mBot under Connect->Serial Port. (Here my mBot's serial port

is COM3, and you can check your mBot serial port under your computer's Device

Manager->Ports (COM&LPT))
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Notes:

1. If you cannot detect any serial port, it may be caused by the following reasons.

a. Failing to install Arduino driver.

Normally when we install mBlock software, Arduino driver will be installed automatically at the

same time. But sometimes we may need to install Arduino driver manually.

For windows users, we can select “Install Arduino Driver” under “connect” and install it easily.
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For Mac OS users, please download and install correct driver as below says:

Below Mac OS sierra users, download this driver;

Mac OS sierra users, download this driver;

Mac OS high sierra users, download this driver.

When choose Serial port under Connect->Serial Port, please choose port similar to

/dev/tty.wchusbserial1410.

b. The power switch of the main board (mCore) has not been turned ON (this cause is only for

mBot/mCore).

c. The Bluetooth connection from the robot may capture the serial port. Remove the Bluetooth

module from the robot while using the USB cable.

d. Paired Bluetooth devices on the PC may interfere the Serial port of the USB connection too.

e. The USB port or USB cable is faulty. Please try changing the USB port (you may change the

PC have a check too), USB cable etc.

2. Cannot find the serial port for my robot on mBlock and there are lots of BT port under the

device manager like below.

http://blog.sengotta.net/wp-content/uploads/2015/11/CH34x_Install.zip
http://www.mblock.cc/docs/run-makeblock-ch340-ch341-on-mac-os-sierra/?noredirect=en_US
http://blog.sengotta.net/wp-content/uploads/2015/11/CH34x_Install.zip
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Cause: The Bluetooth module you paired before would be mapped into COM ports. Even if they

are not present, they still appear in the “Serial Port” list. So, uninstall these paired Bluetooth

devices will resolve this issue.

Solution: disable or uninstall all the Bluetooth ports (COM ports) from the PC.
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How to upgrade firmware for Makeblock robot with mBlock

This article applies to: mBot, mBot Ranger, Starter, Ultimate, Ultimate 2.0

Devices required: PC (here we use windows); Makeblock robot kit (here we use mBot as an

example); USB cable

Step 1

Refer to FAQ to connect your Makeblock robot to mBlock

Step 2

Go to Connect->Upgrade Firmware, wait until it says Upload Finish.

Ps: online debug only works after firmware update.

Note:

what should I do if firmware upgrade fails and shows below picture?
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1. You may select the wrong board.

Please select the corresponding board then try to upgrade firmware or reset default
program.

2. The upload failed issue might be caused by using defective modules, faulty serial
port chip, or faulty main board.

1) Please remove all the modules from main board, including RJ 25 cables, then
upgrade firmware again.

2) If it is still the same issue, try to upload “Blink” program on Arduino IDE
environment to test if the main board lose its bootloader.

PS: Only USB connection allows us to do firmware upgrade.

https://forum.makeblock.com/t/upload-issues-reset-firmware/10879
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How to reset default program manually with mBlock

This article applies to: mBot, mBot Ranger, Starter, Ultimate, Ultimate 2.0

Devices required: PC (here we use windows); Makeblock robot kit (here we use mBot as an

example); USB cable

Step 1

Refer to this FAQ to connect your Makeblock robot to mBlock

Step 2

Go to Connect->Reset Default Program->mBot, wait until it says Upload Finish.
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How to upload my program to the Makeblock robot with

mBlock

This article applies to: mBot, mBot Ranger, Starter, Ultimate, Ultimate 2.0

Devices required: PC (here we use windows); Makeblock robot kit (here we use mBot as an

example; USB cable

Step 1

Refer to this FAQ to connect your Makeblock robot to mBlock

Step 2

Edit your own program, then right click on the program and select upload to Arduino.

Step 3

You can see following page and click on Upload to Arduino.
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Step 4

Then the program will start uploading, wait until it shows Upload Finish.

Notes 1: In case you fail to upload a new program, please refer to below steps to do some

troubleshooting by yourself.
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a. Make sure you strictly follow the above steps to upload the program. (make sure

connected with USB cable, choose correct serial port and Board).

b. Please remove the Bluetooth/2.4G module from the main board, then upload program

again to have a check.

c. If it says “upload finished” when you do upgrade firmware, while says “upload failed”

when upload a new program, please check if there is any other Arduino software installed in the

system. Please close it if there is.

d. If both the Upgrade firmware and upload program fail, try to change the USB cable, USB

port or change a PC to have a check.

e. Try to change some new batteries. According to our test and research, it is suggested to

use rechargeable Li-ion battery or rechargeable nickel-metal hydride, nickel-cadmium which can

be bought from amazon or local shop. Or Alkaline battery with good quality like Energizer,

DURACELL.

Note 2: In case the new program uploaded to my Makeblock robot doesn't take effect.

Please reset default program referring to this FAQ and try again.

If it says “upload finished” but the uploaded program doesn’t take effect, then the board may lose

its bootloader. Please double check it refer to this document.

http://download.makeblock.com/Test%20if%20the%20Arduino%20board%20is%20working%20or%20not%20with%20the%20Blink%20program.pdf
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What is the difference between upgrade firmware and reset

default program

This article applies to: mBot, mBot Ranger, Starter, Ultimate, Ultimate 2.0

Upgrade firmware

This firmware is a built-in program for online programming.

If you want to do the online program as below, we need to do upgrade firmware first.

Online programming & offline programming

mBlock we defined two modes of programming, “online” and “offline”.

“online” mode means programming robot with USB, Bluetooth and 2.4G connection; it is the
computer that sends the instruction to the Robot;
“offline” means using Arduino mode to program robot and upload the program into the controller;
the instructions are running on the Robot;
The difference between “online” and “offline” programming is that “online” uses communication
protocol to instruct Robot, while “offline” runs program on the board, so the “offline” mode has
better efficiency.

You may refer to this FAQ for the steps to upgrade firmware.

Reset default program

This firmware is a preset factory program in the robot (such as manual control mode, obstacle
avoidance mode, line inspection mode of mBot) in order to increase the robot's playability.

Under below situation we need to reset default program for the robot:
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To run default program or controlling the robot with mobile App after we did “upload to Arduino”.
For example, you have uploaded a program to mBot before and now you want to use Makeblock
App to control it, then you need to reset default program. Surely if it is your first time to control it
with Makeblock App and failed, you are also suggested to reset default program.

And for guidance to reset default program, please refer to this FAQ.
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Why my Makeblock robot doesn't move when I set low

motor speed

This article applies to: mBot, mBot Ranger, Starter, Ultimate, Ultimate 2.0

For example, we set the speed value 50 for mBot, here the "50" is not the real speed value. The
real running speed depends on the voltage and speed value.

Here we take mBot as an example:

 The setting speed is 50, and the maximum speed is 255.
 The battery is 3.7V, and it is fully charged.
 The rated voltage is 6V for TT Geared Motor, and the no load speed: 200RPM±10%

)

Thus, setting speed to 50 might be too slow for TT Geared Motors to run. Try 100 above to have a
look.

For other robot kits, setting speed at 20 will not let it move.



19

A Comparison among Bluetooth connection, 2.4G

connection and USB connection

This article applies to: mBot, mBot Ranger, Starter, Ultimate, Ultimate 2.0

We know that there are several ways to connect Makeblock robots and mBlock. There is a chart to
show differences among these connection ways.

Connection

types

Modules

required for

PC mBlock

Features with

PC mBlock

Advantages Disadvantages Main board

supported

USB cable

connection

USB cable Reset default

program; update

firmware;

upload program;

do online

program

Only need one

USB cable

Short USB

cable makes it

inconvenient

mCore, Auriga,

Orion, MegaPi

2.4G wireless

serial

2.4G module

(included a

2.4G wireless

dongle)

Do online

program only

No interference

when there are

several robots in

2.4G connection

cannot work

with Phone App

mCore, Auriga,

MegaPi

Bluetooth

connection

Bluetooth

module

(computer

built-in

Bluetooth

dongle)

Do online

program only

Work with

mobile Apps

like Makeblock

App and

mBlock

Some Bluetooth

module may not

be compatible

with PC built-in

Bluetooth and

connection

stability is not

very good.

mCore, Auriga,

Orion, MegaPi

and the new

bluetooth

module (labeled

with ble_v1_c)

is not working

in this way

Bluetooth

connection

with

makeblock

official dongle

Bluetooth

module and

Makeblock

Bluetooth

dongle

Do online

program; can

also upload

program to

mCore and

Auriga

Good

connection, get

rid of USB

cable

Need to buy a

single

Makeblock

Bluetooth

Dongle

mCore, Auriga,

Orion, MegaPi
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Notes:

1. 2.4G wireless module (included a 2.4G wireless dongle): If you have a mBot Bluetooth version, you can

simply buy a 2.4G wireless module to replace the Bluetooth module.

2. Bluetooth module: for mBot (mCore), Ultimate 2.0 (MegaPi) and mBot Ranger (Auriga), it is Bluetooth

Module. And the newer Bluetooth module (labeled with “BLE_V1_C” doesn’t support PC built-in Bluetooth.

For starter, it is Me Bluetooth Module.

3. Computer built-in Bluetooth dongle: many computers especially laptops can support Bluetooth as it has

built-in Bluetooth dongle. But sometimes there may be incompatibility between computer and Bluetooth module.

And this method is not suggestable, it is non-official usage.

4. Bluetooth connection with dongle: for mCore, Auriga, besides do online programming, connection with

Bluetooth Dongle can upload program and run online program.

5. Makeblock Bluetooth dongle: some computers’ built-in Bluetooth dongle may not be working very well with

Makeblock Bluetooth module, so we strongly suggest to use Makeblock Bluetooth Dongle. And there is no need to

use Bluetooth dongle for mobile App control.

https://www.makeblock.com/project/2-4g-wireless-serial
https://www.makeblock.com/project/bluetooth-moduledual-mode
https://www.makeblock.com/project/bluetooth-moduledual-mode
https://www.makeblock.com/project/me-bluetooth-moduledual-mode
https://www.makeblock.com/accessories-and-others/bluetooth-dongle
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What troubleshooting I can try if my Makeblock robot

cannot connect to my phone App

This article applies to: mBot, mBot Ranger, Starter, Ultimate, Ultimate 2.0

We now have developed Makeblock App which allows us to control and program for Makeblock

robots in one App. Also, Makeblock App supports all Makeblock robots except neuron. So, you

are suggested to download Makeblock App. Also mBlock App is under construction, which

supports mBot, Ranger, Codey Rocky, Neuron, Motion Block, Halocode (soon).

If you find Bluetooth cannot be connected to Makeblock App, please refer to below chart to do
some troubleshooting.

Notes:

1. For starter, we use Me Bluetooth Module, so also check if anything wrong with the port and
RJ25 cable when this issue happens.

2. We can also try to reset default program and upgrade firmware with USB cable connection on
PC mBlock first, and then connect Bluetooth to Makeblock App.

3. Enable GPS and location permission are useful and important sometimes.

http://learn.makeblock.com/en/software/
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Part II mBot

How to replace motor shaft for mBot

There is spare motor shaft in the mBot package, please find it and refer to the video tutorial in this
link to replace it if your shaft is broken: https://www.youtube.com/watch?v=MDb1uWpbK6Y

https://www.youtube.com/watch?v=MDb1uWpbK6Y
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Why the Ultrasonic Obstacle Avoidance Mode doesn’t work

on mBot

If you find your mBot cannot avoid obstacle when you set it in Ultrasonic Obstacle Avoidance
mode, please follow below steps to do troubleshooting.

1. Make sure the ultrasonic module is connected to Port 3 (required by default program).

2. Double check the wiring of the ultrasonic module and make sure the connection is firm and
well. Check whether the red indicator of the ultrasonic module is on. If not, the problem is caused
by wiring.

3. Press button B on the IR remote control to enter Ultrasonic Obstacle Avoidance Mode if you
use the IR remote controller. When it set in Ultrasonic Obstacle Mode, onboard light should be
green on.

4. Refer to this FAQ to reset default program to have a try.

5. Make sure the battery on mBot can provide enough power.

According to our test and research, it is suggested to use rechargeable Li-ion battery or
rechargeable nickel-metal hydride, nickel-cadmium which can be bought from amazon or local
shop. Or Alkaline battery with good quality like Energizer, DURACELL.

6. Write below example program to test the Ultrasonic module. First of all, upgrade firmware,
then click on green flag and move your hand at the front of the Ultrasonic sensor to check the
distance from panda.

Notes: Here the ultrasonic module is connected to port 3.

If it is always 400, that means the module maybe faulty. But you may try to change to port 4 or try
with another RJ25 cable in case faulty cable or port.
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Why the Line Follower Mode doesn't work on mBot

When mBot works properly with Manual mode and Wall avoidance mode but doesn’t work
properly with Line follower mode, please test if the line follower sensor is faulty referring to the
below steps.

Step 1

Put the two sensors of the Me Line follower above (Detection range: 1~2cm) a white desk or
white paper and check if the two LEDs corresponding to the two sensors lit up?

Step 2

Move it away from the white desk or white paper and check if the two LEDs corresponding to the
two sensors turn off?
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If the LED corresponding to each sensor lights up when you put the sensor above a white
paper/desk and goes off when it is away from white paper/desk, which means the line follower
sensor is ok. Otherwise, the sensor should be faulty.

If the sensor is ok according to the above test but the line follower mode doesn’t work, there are
several possible reasons that we should check.

a. The default program may not function properly in mBot, please refer to FAQ3 to reset default
program to have a try.

b. Make sure you have pressed Button C to enter Line Follower Mode if you use the IR remote
controller to control the mBot.

c. The Me Line Follower sensor may not be connected to the correct RJ25 port. Please connect
the Line follower sensor to the Port 2 on mCore board.
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d. The wire connection may be loose or the RJ25 cable between the line follower module and
mCore may be faulty. Please re-plug the RJ25 cable for both sides, or change a RJ25 cable
to have a check.

e. The power from battery is not enough. Please change the battery to have a check.

According to our test and research, it is suggested to use rechargeable Li-ion battery or
rechargeable nickel-metal hydride, nickel-cadmium which can be bought from amazon or local
shop. Or Alkaline battery with good quality like Energizer, DURACELL.
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How to connect 2.4G wireless serial to my mBot

There are three steps to use the 2.4G wireless serial for mBot and mBlock: Upgrade firmware for

mBot with USB cable; Connect with 2.4G wireless serial; Program for mBot and run it online.

1) Upgrade firmware for mBot with USB cable

2) Connect with 2.4G wireless serial: Remove the USB cable, plug the Wi-Fi dongle into your

computer, the light on the mBot’s Wi-Fi module will stop blinking and be steady on. Go to the

Connect -> 2.4G Serial –>Connect (Check that the √ mark stays on, if there is no check

mark after you clicked on ‘Connect’, that means the 2.4G is still disconnected. In this case,

please restart the mBlock software have a try).

3) Program for mBot and run it online: With 2.4G wireless serial connected, you will now

find that you can run the mBot "on-line". That is, starting the command sequence with a

choice from the Events category of commands: "When green flag clicked", "When SPACE

key pressed", etc.

There is also a video to show these steps, you may have a look in this link:

https://www.youtube.com/watch?v=kiO8VYpIGsw

Ps: if there are several 2.4G mBot in same location, please only keep one mBot on and plug in

2.4G dongle, then follow the above steps to pair them. After that, power the second and pair it.

Please keep only one mBot on during pairing.

https://www.youtube.com/watch?v=kiO8VYpIGsw
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How to change the speed of mBot with IR remote controller

If we control the mBot through IR remote controller with the factory default program, the 1-9 keys

on the IR remote controller are set to adjust the speed of mBot. 1 for slowest and 9 for fastest.

We can also write our own program for mBot with mBlock software, which can modify the speed

on following program block:
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Issues related to Battery

1. What is the working voltage of the mCore?

A: 3.7V-6V

2. While the lithium battery of mBot is being charged, is there any protection?

A: Yes. It has over-current and over-charge protection.

3. What is size of mCore battery holder and its cover?

A: Size for the battery holder cover:

Size for the battery holder:
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4. Is there any recommended li-po battery for mBot v1.1

A: The 3.7v rechargeable Li-ion battery is suitable for mBot. Now you can purchase mBot battery
from Amazon:

https://www.amazon.com/Makeblock-iPo-Battery-mBot-3-7V/dp/B07KPVH8H3/ref=sr_1_fkmrn
ull_1?keywords=makeblock+battery&qid=1556507880&s=gateway&sr=8-1-fkmrnull

5. Is there any special phenomenon if the robot cannot get enough power from battery?

A: Currently, there is no visible indicator for low power from battery. But according to our test
and feedback, please check and change the battery if you encounter below phenomenon.

a. Program runs on only when the USB cable is connected, and it won’t do anything once I
unplug the USB cable.

b. Makeblock App fails to connect its Bluetooth when I try to connect them; Or Bluetooth
connection is unstable.

c. Any other abnormal performance that it shouldn’t be.

https://www.amazon.com/Makeblock-iPo-Battery-mBot-3-7V/dp/B07KPVH8H3/ref=sr_1_fkmrnull_1?keywords=makeblock+battery&qid=1556507880&s=gateway&sr=8-1-fkmrnull
https://www.amazon.com/Makeblock-iPo-Battery-mBot-3-7V/dp/B07KPVH8H3/ref=sr_1_fkmrnull_1?keywords=makeblock+battery&qid=1556507880&s=gateway&sr=8-1-fkmrnull
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Useful links for mBot

Instruction downloads

1. Where can I download the program course for mBot

mBlock maker rocks with robots:

https://www.dropbox.com/s/3dwpdyt1ygrpi3t/mBlock%20Kids%20maker%20rocks%20with
%20the%20robots.pdf?dl=0

The Adventures of Mike:

https://www.dropbox.com/s/3v2w8wnym9aubnf/Scratch%202.0%20The%20Adventures%20
of%20Mike.pdf?dl=0

2. The download link for Mac version Arduino driver

http://blog.sengotta.net/wp-content/uploads/2015/11/CH34x_Install.zip

Tutorials for mBot:

1. Video tutorials for mBot: https://www.youtube.com/watch?v=FxAsufUNcII

2. Makeblock Programming Tutorial by 5 Years Old Andy

https://www.youtube.com/watch?v=89VNohLyXeM

3. Tutorial for Combined Line Following and Object Avoidance on mBot

http://learn.makeblock.com/en/tutorial-for-combined-line-following-and-object-avoidance-2/

Function extension projects from Geeks

1. mBot controlled by Wireless Joystick using Me USB Host

https://forum.makeblock.com/t/mbot-controlled-by-wireless-joystick-using-me-usb-host/1658

2. Programming with Scratch X for Makeblock mBot

http://www.instructables.com/id/Programming-With-Scratch-X-for-Makeblock-MBot/

3. How to make mBot follow objects with Pixy CMUcam5 Image Sensor

http://openlab.makeblock.com/topic/57e1e26b695004350cceb478

4. Makeblock mBot default program with added servo features

http://alpermbot.blogspot.com.tr/

https://www.dropbox.com/s/3dwpdyt1ygrpi3t/mBlock%20Kids%20maker%20rocks%20with%20the%20robots.pdf?dl=0
https://www.dropbox.com/s/3dwpdyt1ygrpi3t/mBlock%20Kids%20maker%20rocks%20with%20the%20robots.pdf?dl=0
https://www.dropbox.com/s/3v2w8wnym9aubnf/Scratch%202.0%20The%20Adventures%20of%20Mike.pdf?dl=0
https://www.dropbox.com/s/3v2w8wnym9aubnf/Scratch%202.0%20The%20Adventures%20of%20Mike.pdf?dl=0
http://blog.sengotta.net/wp-content/uploads/2015/11/CH34x_Install.zip
https://www.youtube.com/watch?v=FxAsufUNcII
https://www.youtube.com/watch?v=89VNohLyXeM
http://learn.makeblock.com/en/tutorial-for-combined-line-following-and-object-avoidance-2/
http://forum.makeblock.cc/t/mbot-controlled-by-wireless-joystick-using-me-usb-host/1658
http://www.instructables.com/id/Programming-With-Scratch-X-for-Makeblock-MBot/
http://openlab.makeblock.com/topic/57e1e26b695004350cceb478
http://alpermbot.blogspot.com.tr/
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Extended programming method for mBot

1.Use mBot with iOS (Swift)

http://learn.makeblock.com/en/use-mbot-with-ios-swift/

2.python-for-mbot

https://github.com/xeecos/python-for-mbot

3.Different language with Makeblock products:

https://shimo.im/doc/7D1Z1WfJa1c5XFJj

Others

1. Use mBot with App Inventor:
http://learn.makeblock.com/en/use-mbot-with-app-inventor/

2. Makeblock mBot Protocol:
http://learn.makeblock.com/en/makeblock-orion-protocol/

3. mBot Serial Port Protocol:
http://learn.makeblock.com/en/mbot-serial-port-protocol/

4. User Makeblock Computer Vision Extension for App Inventor
http://learn.makeblock.com/en/user-makeblock-computer-vision-extension-for-app-invent
or/

http://learn.makeblock.com/en/use-mbot-with-ios-swift/
https://github.com/xeecos/python-for-mbot
https://shimo.im/doc/7D1Z1WfJa1c5XFJj
http://learn.makeblock.com/en/use-mbot-with-app-inventor/
http://learn.makeblock.com/en/makeblock-orion-protocol/
http://learn.makeblock.com/en/mbot-serial-port-protocol/
http://learn.makeblock.com/en/user-makeblock-computer-vision-extension-for-app-inventor/
http://learn.makeblock.com/en/user-makeblock-computer-vision-extension-for-app-inventor/
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Part III Ranger

Why the motors are not working properly as they should be

Situation 1Motor(s) is not turning at all when command given.

Please check:

a. Make sure the wheels are installed correctly as there are wheels in different sizes.
b. Cable from motor to the main board is connected properly and make sure the cables are
working.
c. If the Makeblock App cannot let it move, try to write an online program or upload a program in
mBlock like below to test:

Remember to upgrade firmware before running an online program.

d. Check if there is anything get stuck in the wheels, like cables. You can turn the wheels in
clockwise or anti-clockwise order to test.
e. Try some new batteries.
f. It may not move if the speed is too slow like 20 or 30. So try speed at 200.

Situation 2 Ranger cannot move straightly (two motors have different speed)

Due to the motors’ installation difference, it is normal that two motors don’t have exactly same
speed. If they differ a lot, please check:
a. If there is anything get in the left or right wheel, like cables.

b. Speed is set too slow that one side moves a little while the other side doesn’t move. So try a
larger speed like 100.

c. Motors cannot get enough power energy. Try to change the battery or charge the battery.

If the speed of both sides still differs a lot, you may try to adjust the speed to with different power,
like setting left speed as 100, while right 110. Several tests are necessary to get expected result.

Situation 3 Ranger moves forward when I tap backward?
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This should be caused by wrong wiring. So, change the M1 and M2 connection.

Situation 4 Ranger doesn’t move constantly and sometimes there is sound from the main board.

a. The speed level maybe too low, try a higher like 200 to test.

b. Battery cannot provide enough power, try new battery to test.
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Can I use 2.4G wireless module for my Ranger

I. Is it possible to replace the Bluetooth connection with a 2.4G wireless module?
Yes. As the module connection interface is the same with Ranger Bluetooth module.

II. How to use 2.4G wireless connection?
Refer to mBot FAQ How to connect 2.4G wireless serial to my mBot.
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Why the Ranger cannot avoid objects in object avoidance

mode

A. Check wiring. The default setting for Ranger object avoidance mode is that the ultrasonic
sensor connects to Port 10 on Auriga port.

B. Download and install the latest version mBlock software, then reset default program for
Ranger.

C. Test if the Ultrasonic sensor is defective.

How to test if the ultrasonic sensor is defective?

1. Download and install the latest version of Makeblock software on your PC. If you have a Mac,
then you also need to install a driver.

2. Connect Ranger with PC via USB.
3. Make sure the ultrasonic module is connected to Port 10 (required). You should feel a slight

click when the RJ 25 cable is properly inserted.
4. Check whether the red indicator of the ultrasonic module is on. If not, the problem is caused

by wiring.
5. Upgrade firmware.
6. Try to run this program, and move your hand in front of the ultrasonic sensor.

7. If the panda doesn't say an ever-changing number, try to change another RJ 25 cable to
connect the ultrasonic sensor and the Port 9. Then try to repeat the above instruction 3-6.

8. If the step 7 doesn't work for you either, attach the RJ25 cable with the ultrasonic sensor with
port 8. Then try to run the program example, but choose "ultrasonic sensor Port 8 distance"
this time.

9. If the panda does say ever-changing number, please reset default program for Ranger, then try
the obstacle avoidance mode again.
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What should I do if the Nervous Bird could not keep

balanced?

When you find the Nervous Bird cannot keep balanced, please refer to the below steps to check:

1. Make sure you did follow the guidance strictly to assemble it.
2. Make sure power is enough as self-balancing robot requires to be working with full power. If
you are sure assembling is perfect but it still fails to be balanced, please do insert 6 totally new
batteries in. This is very important.
3. Make sure the Gyro module is working properly. You can write a simple program to test the
module.
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Questions related to Bluetooth connection on Mobile devices

I. What Apps do you have for Ranger?
For mobile devices, there are mBlock and Makeblock App that support Ranger. Makeblock App
requires Android 4.3+ and iPhone 4S/iPad 3 +, iOS 9+. mBlock requires Android 5.0 + and iOS
9+. You can search Makeblock in googleplay or appstore.

II. How to connect Ranger to Makeblock App?
As Makeblock App connects to Ranger via Bluetooth, make sure Bluetooth module is plugged
properly. Download and install the latest Makeblock App and refer to below steps to connect
Ranger:

1. Power on Ranger and there is a blue LED keeping slow flashing on the Bluetooth module.
2. Open the Makeblock APP on mobile device and move the mobile device close to the Bluetooth
module, normally it will connect automatically.
Note: if you use iOS mobile device, you need open Bluetooth function on mobile device first.

3. If the Bluetooth can’t be connected automatically, please go to Search icon on the upper right
corner, check if you can find the Ranger Bluetooth in the detected list. If there is, please connect to
it from the list.
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III. What is the troubleshooting if my Ranger fails to connect Makeblock App through
Bluetooth?
If you tried above steps to connect Bluetooth but failed, please follow below chart to check step by
step.
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Note: Battery is very important, for any abnormal phenomenon happens to the robot, you are
strongly suggested to change new battery.

If you fail to connect in mBlock App, you can also refer to the above chart.
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IV. Why iPad 2 and below doesn't support Bluetooth from Makeblock

The Bluetooth module on our product supports BLE protocol, while for Apple products, only the

products published after the year 2011 support BLE protocol which can work with the Bluetooth

on our product.

Since the iPad 2 doesn't support BLE protocol, so it cannot work with our APPs which need

connect with Bluetooth.

The APPs of our product work with iPad 3 and above and the iOS should be iOS 9.0 and above.

V. The Bluetooth connection to the Ranger is unstable?

For the issue that the Bluetooth connection is unstable between Robot and Makeblock App, it may

be caused by the power issue, or the Bluetooth module is not well plugged. So, you may change

the battery for the Ranger to have a try since it is easy to lead disconnect issue on Bluetooth when

it lacks power.

According to our test and research, it is suggested to use rechargeable Li-ion battery or

rechargeable nickel-metal hydride, nickel-cadmium which can be bought from amazon or local

shop. Or alkaline battery with good quality like Energizer, DURACELL.

Besides, please check if the issue goes to the same when use other devices.
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What should I do if the Makeblock App says

“synchronization fails”

Problem:

When I try to connect Bluetooth in Makeblock App, the screen says “synchronization fails” as
below picture:
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Solution:
Connect Ranger to PC, open mBlock 3 or 5 and do reset default program.
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Why my Ranger moves once I turn it on

Problem:
Once I turn on my Ranger, it moves very fast. Everything connected well, and I reset default
program with PC software mBlock 3, it doesn’t help.

Cause:
This Ranger was set to Nervous Bird in the Makeblock App (or in mBlock3) and was turned off,
then the Ranger is assembled to another form like Land Ralder, at this time, once we turn on the
power, it will move automatically and won’t listen to the command.
Reset default program or upgrade firmware won’t help this issue.

Solution:
1) Through Makeblock App: turn on the robot though it is moving (you can hold it), go to

Makeblock App, choose the correct mode (instead of Nervous Bird) when connect Bluetooth.
Once connected, it will stop moving.

2) Through mBlock 3: connect robot to mBlock as this guide, then go to connect>set firmware
mode>Bluetooth mode or the mode you need instead of balance mode (nervous bird). After
that, it won’t move once you turn it on.
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Why the line follower doesn’t work on Ranger?

There are several possible reasons, please check one by one:

1) The line follower module doesn’t connect to Port 9 on Auriga as requested.
2) The map is placed in a place where is surrounded by bright lights, such as under the sunlight,

or very close to the lights in the room. Please move it to a darker place to do the test.
3) If the line follower module is connected to Port 9 but Ranger still cannot follow the line,

please reset default program on mBlock software environment. It might be the line follower
faulty or other hardware issues.

Please follow below steps to test the line follower module.

Step 1: Put the two sensors on the Me Line follower above (Detection range: 1~2cm) a white desk
or white paper and check if the two LEDs corresponding to the two sensors lit up?

Step 2: Remove the line follower sensor from the white desk or white paper and check if the two
LEDs corresponding to the two sensors turn off?
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If the led corresponding to each sensor lit up when above a white paper/desk and turn off when
remove from the white paper/desk, means the line follower sensor is ok. Otherwise, the sensor
should be faulty.
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Part IV Starter

What should I do if my starter motors are not working

properly

Situation 1Motor(s) is not turning at all.

Please check:

1.Cable from motor to the main board is connected properly and make sure the cables are
working.
2.If the IR controller or Makeblock App cannot let it move, try to write an online program or
upload a program like below to test:

Remember to upgrade firmware before running an online program.

3.Check if there is anything get stuck in the wheels, like cables. You can turn the wheels in
clockwise or anti-clockwise order to test.
4.Try some new batteries.
5.It may not move if the speed is too slow like 20 or 30. So try speed at 100+.

Situation 2 Starter cannot move straightly (two motors have different speed though set to same
value)

Due to the motors’ installation difference, it is normal that two motors don’t have exactly same
speed. If they differ a lot, please check:
1. If there is anything get in the left or right wheel, like cables.

2. Speed is set too slow that one side moves a little while the other side doesn’t move. So, try a
larger speed like 100.

3. Motors cannot get enough power energy. Try to change the battery or charge the battery.

If the speed of both sides still differs a lot, you may try to adjust the speed to with different power,
like setting left speed as 100, while right 110. Several tests are necessary to get expected result.
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Situation 3 Starter always works in wrong direction, it doesn't move according the commands on
IR remote or Makeblock APP

1.When it was given “turn left” command, the robot turns right, when given “turn right” command,
it turns left. The reason should be the motors are connected to the wrong motor interfaces M1, M2
(Yellow) on Orion board, please switch the places of the two motors.

2.When given “move forward” command, it moves backward, while “move backward” command,
it moves forward. The reason is the two thin wires (white and black) coming from each motor are
inserted into the yellow interface in wrong order. Please switch the order of the two wires for each
motor. (You can screw loose the screws, then insert the wires and screw them tight)

There may be other situation too, but normally you can fix it by checking the wiring connection
and order and correcting them.
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What is the difference between Starter IR version and

Bluetooth version

You can control the IR version Starter with IR controller, and control the Bluetooth version Starter
with Makeblock APP on mobile devices.

That is the only difference as IR version starter includes the Me Infrared Receiver Decode and IR
Remote Controller, while the Bluetooth version starter doesn’t includes these two parts, but a Me
Bluetooth module instead.

If you have bought an IR version Starter and you want to control it with mobile APP too, you just
need to buy an extra Me Bluetooth module for the robot. The same to the Bluetooth version.

https://www.makeblock.com/project/me-infrared-reciver-decode
https://www.makeblock.com/project/me-ir-remote-controller
https://www.makeblock.com/project/me-ir-remote-controller
https://www.makeblock.com/project/me-bluetooth-moduledual-mode
https://www.makeblock.com/project/me-bluetooth-moduledual-mode
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How to play with IR version Starter

I. How to control Starter under default mode
Below is the command of each key on the IR controller. If it is not working, please use mBlock 3
to reset default program as this guide.

If it works in the PC software mBlock but not with the IR controller, please test if the IR controller
and IR module is working or not.

a. Make sure the IR controller has installed correct number and correct type of batteries. Open the
camera application on an Android phone, and put the Infrared head on the IR remote controller
toward to the camera on the Android phone, then press the key on the IR remote controller.
Meanwhile, through the camera on Android phone, notice if you can see the red light from the
Infrared head. If there is red light means the IR remote controller is working.

Note: the red light should be always on (or a very quick flash) when you keep holding a button on

IR Controller.

b. Test the communication between the remote and the Infrared Receiver.
 Turn on the power switch of Starter. Long press the number button on remote. The

indicator D3 should have blue light on.
 The blue light should be off once you released the button.
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 If there are no lights on, which means the infrared receiver cannot communicate with the
remote.

II. Program for the IR controller instead of using default program.
First of all, learn the Code of each key

Then you can write your personal program. Here is an example.
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Can I use 2.4G module to replace the Bluetooth module on

Starter

Here is Starter Bluetooth Module, with RJ 25 connector.

While the 2.4G module interface is different:

So, we cannot use 2.4G module to replace the Bluetooth module. That is too say, Starter doesn’t
support 2.4G module.
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Questions related to Bluetooth connection on Mobile devices

I. What Apps do you have for Starter?
For mobile devices, there is Makeblock App that supports Starter. It requires Android 4.3+ and
iPhone 4S/iPad 3 +, iOS 9+.

II. How to connect Starter to Makeblock App?
As Makeblock App connects to Starter via Bluetooth, we have to use Bluetooth version Starter. Or
buy a separate Me Bluetooth Module for IR version Starter.

Download and installed latest Makeblock App and refer to below steps to connect Starter:

1. Connect the Me Bluetooth module to Port 5 on Orion board.

2. Power on the Starter and there is a blue LED keeping slow flashing on the Me Bluetooth
module.

3. Open the Makeblock APP on mobile device and move the mobile device close to the Bluetooth
module, normally the Starter Bluetooth will connect automatically.

Note: if you use iOS mobile device, you need open Bluetooth function on mobile device first.

3. If the Bluetooth can’t be connected automatically, please go to Search icon on the upper right
corner, check if you can find the starter Bluetooth in the detected list. If there is, please connect to
it from the list.
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Note:

Sometimes you may see the screen says “synchronization fails”, which means the Starter current
firmware is not compatible with Makeblock App, please connect it to mBlock 3 and reset default
program.

III. What is the troubleshooting if my Starter fails to connect Makeblock App through
Bluetooth?
If you tried above steps to connect Bluetooth but failed, please follow below chart to check step by
step.
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Note: Battery is very important, for any abnormal phenomenon happens to the robot, you are
strongly suggested to change new battery.

And many cases show that GPS should be enabled for Makeblock App.

IV. Why iPad 2 and below doesn't support Bluetooth from Makeblock

The Bluetooth module on our product supports BLE protocol, while for Apple products, only the

products published after the year 2011 support BLE protocol which can work with the Bluetooth

on our product.

Since the iPad 2 doesn't support BLE protocol, it cannot work with our APPs which need connect

with Bluetooth.

The APPs of our product work with iPad 3 and above and the iOS should be iOS 9.0 and above.

V. The Bluetooth connection to the Starter is unstable?

For the issue that the Bluetooth connection is unstable between Robot and Makeblock App, it may

be caused by the power issue, or the Bluetooth module is not connected well to Port 5 on Orion

board, or you may change the battery for the Starter have a try since it is easy to lead disconnect

issue on Bluetooth when it lacks power.
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According to our test and research, it is suggested to use rechargeable Li-ion battery or

rechargeable nickel-metal hydride, nickel-cadmium which can be bought from amazon or local

shop. Or alkaline battery with good quality like Energizer, DURACELL.

Besides, please check if the issue goes to the same when use other devices.
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What I should do when Ultrasonic Obstacle Avoidance Mode

of my Starter fails to work

1. Make sure the ultrasonic module is connected to Port 3 (required) on Orion board.

2. Check whether the red indicator of the ultrasonic module is on. If not, the problem is caused by
wire connection or the sensor itself.

3. If you control the Starter with IR remote controller, need press mode switch button D on the IR
remote control to switch to Ultrasonic Obstacle Avoidance Mode.

4. The starter may lose its default program.

5. Make sure the battery on starter can provide enough power.

According to our test and research, it is suggested to use rechargeable Li-ion battery or
rechargeable nickel-metal hydride, nickel-cadmium which can be bought from amazon or local
shop. Or Alkaline battery with good quality like Enegizer, DURACELL.

6. Test the Ultrasonic sensor.

Here is an example to test the ultrasonic sensor:

Move the hand at the front of the Ultrasonic sensor when the program is running. If it always says
400 or less than 1 which is abnormal, please try:

a. Upgrade firmware and test the above program again
b. Change the RJ25 cable between the Ultrasonic module and main Board (you can

temporarily use the RJ25 cable from other modules).
c. Connect the Ultrasonic module to Port 4 instead port 3, then modify the above program

to Port 4 and see if there is valid data from Ultrasonic module.
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How to check if the Starter main board lose its bootloader

When your uploaded program is not working with the Starter, you need to check if the main board
is working or not. Below are the steps.

1. Please open the Arduino software through the mBlock software:

2. On Arduino software, go to Tools->Board and choose the correct Board type for
your robot. If it is mBot, Starter, Ultimate Blue, here you can choose the Arduino/Genuine
Uno.
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3. Go to Tools->Port, then choose the correct serial port for your robot. You can
check your robot/main board serial port under your computer's Device Manager->Ports
(COM&LPT))

4. Go to File->Examples, find and open the example program file “Blink”.



61

5. Upload the program to the Robot and see if it can be upload successfully.
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Result:

1. If the program upload successfully. Please check if there is a LED keep blinking

on the Main board. If there is a led blinking, it means the main board is working ok.

2. If there is an error like below, it means the board has lost its bootloader.

Normally you need a new board in this case. If you have two Orion boards and you are
experienced with this staff, you can try to follow this post to reburn bootloader. But
usually you are suggested to contact Makeblock support.

https://forum.makeblock.com/t/how-to-wiring-when-i-want-to-reburn-bootloader-for-a-orion-board-with-another-orion-board/7584
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Questions for Starter Battery

Working voltage of Starter/Orion

6-12V

Output voltage

5V

How to power on the Starter

A. 6 AA batteries (not included in the package)

B. 6-12V DC Rechargeable Li-ion Battery Pack

And you are suggested to choose B. Here are the suggestions from other users:

https://forum.makeblock.com/t/12v-rechargable-battery/707/12

https://forum.makeblock.com/t/mbot-ranger-best-high-capacity-lipo-battery/5103/7

Power adapter specification

DC 5.5*2.1mm, Orion, Auriga and MegaPi use same; while mCore is DC 3.5*1.1mm

Note: Any abnormal/improper behavior happens to your robot, like fails to move, Bluetooth
cannot connect, etc, you should check the battery and try some new battery.

https://forum.makeblock.com/t/12v-rechargable-battery/707/12
https://forum.makeblock.com/t/mbot-ranger-best-high-capacity-lipo-battery/5103/7
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How to program the add-on Robotic Arm for Starter

The best way to use the Robotic Arm is controlling the Arm with mobile APP (Makeblock

APP). In this case, you need the Bluetooth version starter (you may need buy a Bluetooth

module individually if you only have IR version Starter)

If you have IR version starter instead of Bluetooth version, you can program for the Robot Arm

with the mBlock software:

Program for the arm, actually, you only need to program the 37 motor which drives the arm and

the motor in the Gripper.

About programming with mBlock IDE for the 37 Motor and Gripper, you can see the 37 motor is

connected to Port 2 on Orion board and Gripper is connected to Port 1 on Orion board. Below is

an example program.
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Finally, if you want to control the arm and gripper with IR remote controller, you need program
the IR controller and refer to this post:

http://forum.makeblock.com/t/trouble-programming-ir-buttons-in-3-2/3131/9

http://forum.makeblock.com/t/trouble-programming-ir-buttons-in-3-2/3131/9
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Part V Ultimate 2.0

What should I do if my Ultimate 2.0 motors are not working

properly

Situation 1Motor(s) is not turning at all.

Please check:

a. Make sure the motors are installed and connected correctly.
b. Cable from motor to the main board is connected properly and make sure the cables are
working.
c. Check if there is anything get stuck in the wheels, like cables. You can turn the wheels in
clockwise or anti-clockwise order to test.
d. Try some new batteries.
e. It may not move if the speed is too slow like 20 or 30. So try speed at 200.
This is Ultimate 2.0 instruction link.

Situation 2 Ultimate 2.0 cannot move straightly (two motors have different speed)

Due to the motors’ installation difference, it is normal that two motors don’t have exactly same
speed. If they differ a lot, please check:
a. If there is anything get in the left or right wheel, like cables.

b. Speed is set too slow that one side moves a little while the other side doesn’t move. So try a
larger speed like 100.

c. Motors cannot get enough power energy. Try to change the battery or charge the battery.

If the speed of both sides still differs a lot, you may try to adjust the speed to with different power,
like setting left speed as 100, while right 110. Several tests are necessary to get expected result.

Situation 3 Why it moves backward when I ask it to move forward? It unclamps when I tap
clamp?

It is wiring issue. Check the wiring refer to below chart.

https://www.makeblock.com/steam-kits/mbot-ultimate-2
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Questions related to Bluetooth connection on Mobile devices

I. What Apps do you have for Ultimate 2.0?

For mobile devices, Makeblock App that supports Ultimate 2.0. It requires Android 4.3+ and
iPhone 4S/iPad 3 +, iOS 9+.

II. How to connect Ultimate 2.0 to Makeblock App?

As Makeblock App connects to Ultimate 2.0 via Bluetooth, make sure Bluetooth module is
plugged properly. Download and installed latest Makeblock App and refer to below steps to
connect Ultimate 2.0:

1. Power on the Ultimate 2.0 and there is a blue LED keeping slow flashing on the Bluetooth
module.

2. Open the Makeblock APP on mobile device and move the mobile device close to the Bluetooth
module, normally it will connect automatically.

Note: if you use iOS mobile device, you need open Bluetooth function on mobile device first.

3. If the Bluetooth can’t be connected automatically, please go to Search icon on the upper right
corner, check if you can find the Ultimate 2.0 Bluetooth in the detected list. If there is, please
connect to it from the list.
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Note:

Sometimes you may see the screen says “synchronization fails”, which means the Ultimate 2.0
current firmware is not compatible with Makeblock App, please connect it to mBlock 3 and reset
default program.

III. What is the troubleshooting if my Ultimate 2.0 fails to connect Makeblock App through
Bluetooth?
If you tried above steps to connect Bluetooth but failed, please follow below chart to check step by
step.
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Note: Battery is very important, for any abnormal phenomenon happens to the robot, you are
strongly suggested to change new battery.

IV. Why Ipad 2 and below doesn't support Bluetooth from Makeblock

The Bluetooth module on our product supports BLE protocol, while for Apple products, only the

products published after the year 2011 support BLE protocol which can work with the Bluetooth

on our product.
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Since the iPad 2 doesn't support BLE protocol, so it cannot work with our Apps which need

connect with Bluetooth.

The Apps of our product work with iPad 3 and above and the iOS should be iOS 9.0 and above.

V. The Bluetooth connection to the Ultimate 2.0 is unstable?

For the issue that the Bluetooth connection is unstable between Robot and Makeblock App, it may

be caused by the power issue, or the Bluetooth module is not well plugged. So, you may change

the battery for the Ultimate 2.0 to have a try since it is easy to lead disconnect issue on Bluetooth

when it lacks power.

According to our test and research, it is suggested to use rechargeable Li-ion battery or

rechargeable nickel-metal hydride, nickel-cadmium which can be bought from amazon or local

shop. Or alkaline battery with good quality like Energizer, DURACELL.

Besides, please check if the issue goes to the same when use other devices.
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Can I use 2.4G wireless module to control my Ultimate 2.0

I. Is it possible to replace the Bluetooth connection with a 2.4G wireless module?
Yes. As the module connection interface is the same.

II. How to use 2.4G wireless connection?

You can refer to this mBot FAQ to connect.
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What should I do if the self-balancing robot could not keep

balanced?

When you find the Ultimate 2.0 -- Self-Balancing Robot cannot keep balanced, please refer to
below steps to check:

1. Make sure you did follow the guidance strictly to assemble the self-balancing robot. In
Ultimate 2.0 package, there are 3 motors, remember to use the two 9V/185RPM motors. Here is
the guidance of self-balancing robot, including assembling video:
https://openlab.makeblock.com/topic/5729b96b591c0ad43a4764b2

2. Make sure power is enough as self-balancing robot requires to be working with full power. If
you are sure assembling is perfect but it still fails to be balanced, please do insert 6 totally new
batteries in. This is very important.

3. Make sure the Gyro module is working properly. You can write a simple program to test the
module.

https://openlab.makeblock.com/topic/5729b96b591c0ad43a4764b2
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Questions about Ultimate 2.0 Battery

Working voltage of Ultimate 2.0/MegaPi

6-12V

Output voltage

5V

How to power on the Ultimate 2.0

6 AA batteries (not included in the package)

6-12V DC Rechargeable Li-ion Battery Pack

And you are suggested to choose B. Here are the suggestions from other users:

https://forum.makeblock.com/t/12v-rechargable-battery/707/12

https://forum.makeblock.com/t/mbot-ranger-best-high-capacity-lipo-battery/5103/7

Power adapter specification?

DC 5.5*2.1mm, Orion, Auriga and MegaPi use same; while mCore is DC 3.5*1.1mm

Note: Any abnormal/improper behavior happens to your robot, like fails to move, Bluetooth
cannot connect, etc, you should check the battery and try some new battery.

https://forum.makeblock.com/t/12v-rechargable-battery/707/12
https://forum.makeblock.com/t/mbot-ranger-best-high-capacity-lipo-battery/5103/7
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Why my Ultimate 2.0 starts to run every time I turn it on

Problem:

Once I turn on the robot, it begins to run at fast speed and it doesn’t listen to my command.

Reason:

The reason should be that we changed its form/mode to self-balancing robot in Makeblock App and the powered it

off, then when we reassemble it to other form like robotic arm tank, it will run once we power it on.

Solution:

To fix the issue, power on the main board, then connect it with Makeblock App and change the
mode to correct one, then it will stop running and listen to your control.



76

Part VI LaserBot

How to test if the wire connection for X, Y axis connected

properly on Laserbot

Please kindly test it through home position referring to the following steps:

1. Manually move the carriage to a position (any position where X>0, Y>0).

2. Power on the Laserbot and connect it to PC with USB cable.

3. Upgrade firmware for it with mLaser software as below picture.

4. After upgrade firmware done, reconnect USB cable and connect serial port on mLaser.
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5. Go to test if the LaserBot works with home position (refer to steps below):

If the carriage goes to Home position (X=0, Y=0) properly, means both the X axis and Y axis are
working.
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How to test your Laser to see if it is Faulty

Learn how to troubleshoot the following laser symptoms.

 The LaserBot is assembled and the XY module works appropriately, but the laser doesn’t
work.

 Laser doesn’t turn on while the fan rotates fine.

This test requires to connect the laser directly to the power supply. Please use the adapter which
comes with the kit to do the test.

1. Plug the power adapter (12V/2A) into a working AC wall outlet.

2. Put laser’s black and red wires metallic parts to touch the DC connector.

3. Red in, black out.
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Only put red wire metallic part inside of the DC connector interface, the laser is off. Then
make the black wire metallic part touch the interface metal outside, check if the laser turns on.

Notes: If the wire didn't touch with the inner metal part of the DC connector, the laser won't
work. Sometimes, if we spin the wire metallic part inside of the DC connector in different
directions, to make the wire metallic part contact the metal part, then the laser works.
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4. Black in, red out.
If the laser still keeps off, please switch the red wire metallic part and black wire metallic part
to test it again have a try (put the black wire metallic part touch the inner metal part of the DC
connector, then touch the interface metal outside with red wire metallic part, check if the laser
turns on.

5. Please also check if the small fan above the laser rotates while testing.
Here is location of the small fan.
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Conclusion:

If both the laser and the small fan don’t work during above test, the module wire which should
connect to the power is faulty.

If the fan works but the laser doesn’t turn on, it should be the laser problem.
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Why the laser head reaches to the X-axis or Y-axis without

stop

Issue: The laser head reaches to the X-axis or Y-axis without stopping.

Reason: The limit switches on X-axis or Y-axis connect to the wrong pins on MegaPi.

Troubleshooting:

1. In the "self-test", check if the icon X and Y turns into green when press the corresponding
limit switch. As the video “Software Tutorial of LaserBot” shows starting from 00:59.

https://www.youtube.com/watch?v=ieYN2p6OLt4
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If the X icon turns green while pressing Y-axis limit switch, which means both X-axis and
Y-axis limit switch connecting to the wrong pins. Please check if the X-Axis limit switch
connects to A6 on MegaPi, and Y-Axis limit switch connects to A7 as picture shown below.
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2. Check both X-axis and Y-axis limit switch, make sure the pin doesn't connect to anything as I
circled below.
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3. If you have followed step 1 and 2, but it is still the same issue, please switch the position of
limit switches. Put the X-axis limit switch on Y-axis, and the Y-axis limit switch on X-axis,
then test step 1 again.
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How to fix if the X or Y-axis cannot move when test home?

Issue: The X-axis or Y-axis cannot move while clicking the home button on mLaser.

I. Wiring

1. Make sure the motor which control X axis is connected to correct motor port (Port 1) on
MegaPi. The motor which controls Y-axis is connected to Port 2 on MegaPi.

2. Make sure the wire connection is plugged into the particular port properly without loose.

3. Make sure the MegaPi stepper motor driver is plugged well. You can re plug it have a try.

4. Make sure the line order of the color wires for the motor is inserted correctly.
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5. Make sure you have screwed each color wire into the hole on green interface properly:

6. If you have other Makbelock’s drivers which didn’t come with the LaserBot kit, please check if
the LaserBot has been installed the wrong motor driver.

1) The picture shown below shows that the LaserBot has been supplied with encoder
motor drivers. The correct motor driver for LaserBot is called MegaPi Stepper Motor Driver.

2) The picture below shown the LaserBot has installed the correct stepper motor drivers.

https://store.makeblock.com/megapi-stepper-motor-driver
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II. Testing on mLaser

1. Click "Enter mLaser"

2. After update firmware successfully, remove the USB cable. Open mLaser again, connect serial
port on "Serial" until it shows connected.
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3. Click "control panel," then click Y+, Y-, X+, X-, check if the laser head could move to the
expected direction. If one of them doesn't move, then swap the driver and do the test again.
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Why does the LaserBot cut or engrave the image in different

size on X axis (or Y axis)

If the LaserBot cuts or engraves the image in different size on X axis (or Y axis) as the picture
shown below (the image's Y axis is stretched), here are troubleshooting you could try.

1. Update firmware.

2. Swap the two motor drivers’ position on Mega Pi and check if the image’s X axis is stretched
(like the second picture below).
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3. If the other axis of the image is stretched after switched the driver position, one of the
motor drivers is faulty.
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Why the serial port of LaserBot doesn’t appear on mLaser

while using Mac?

Issue: The LaserBot connects to Mac via USB cable, but the serial port doesn’t appear on mLaser.

Reason: For Mac users, you need to download driver in order to run mLaser.

1. For Mac OS Sierra user, please follow the instruction on this link to install driver

(http://www.mblock.com/docs/run-makeblock-ch340-ch341-on-mac-os-sierra/). Please note to

allow "app downloaded from anywhere".

Note: if the driver can’t be installed properly, please follow the video instruction to set allow

apps downloaded from "anywhere".

2. For other Mac users, including Mac OS High Sierra users, please download the driver on this

link

https://blog.sengotta.net/signed-mac-os-driver-for-winchiphead-ch340-serial-bridge/

3. When choose Serial port under Connect->Serial Port, please choose the port similar to

/dev/tty.wchusbserial1410.

4. If you could update firmware this time, remember to unplug the USB after successfully updated,

then plug the USB back to LaserBot again.

http://www.mblock.cc/docs/run-makeblock-ch340-ch341-on-mac-os-sierra/).
https://www.youtube.com/watch?v=A6EUI5kn1vM
https://blog.sengotta.net/signed-mac-os-driver-for-winchiphead-ch340-serial-bridge/
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How should I enter mLaser when the opening page is in

Chinese

Recently, we got some feedback regarding the language setting issue of mLaser. Even though the
installation language is set as English, the very first page after installation is still Chinese. We
have reported this issue to related personnel, and you could follow the instruction below to enter
the main interface before the problem solved. The following pictures are showing the
corresponding English version mLaser.

1. Download the latest version mLaser V2.4 from this link:
https://www.makeblock.com/project/laserbot

2. Enter password at the login page
Password: 123

https://www.makeblock.com/project/laserbot
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3. Select “Enter mLaser”
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4. Go to the language setting at the top right corner.
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5. Close mLaser and reopen it. You will find the menu is in English, and you could test LaserBot
now.
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Why the interface of the mLaser is black rather than white

Issue: In some cases, the interface of the mLaser appears black rather than white in older
computer systems.

Reason: The graphics driver of the computer is out of date.

Troubleshooting:

1. Please update the computer graphics driver to the latest version.
2. If step 1 doesn’t help, please use another PC to install mLaser.
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Why the mLaser showed damaged when I opened it on my

Mac

Please follow the instruction to solve this issues:
http://www.tech-recipes.com/rx/45404/mac-downloaded-app-is-damaged-and-cant-be-opened-erro
r-solved/

For Mac OS Sierra, here is a video tutorial for your reference:
https://www.youtube.com/watch?v=A6EUI5kn1vM

http://www.tech-recipes.com/rx/45404/mac-downloaded-app-is-damaged-and-cant-be-opened-error-solved/
http://www.tech-recipes.com/rx/45404/mac-downloaded-app-is-damaged-and-cant-be-opened-error-solved/
https://www.youtube.com/watch?v=A6EUI5kn1vM
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Why the Laser is on but it cannot cut or engrave anything?

When you engrave or cut an image, if the laser is on but there is nothing on the

wood/leather/cardboard/paper etc, or the graphics are not clear, here are the trouble shoot we

could try together.

1. Adjust the laser light according to this video tutorial.

Figure 1

2. When you engrave an image: you can modify the Laser Power and the Engraving Time,

please refer to figure 2.

(you can check the definition for the Laser Power and Engraving Time parameters on figure 3).

http://download.makeblock.com/laserbot/video/161018%20Software%20toturial%20of%20laserBot%EF%BC%88English%EF%BC%89.mp4
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(Figure 2)

(Figure 3)

When you cut an image: you need choose the correct Material, then you can adjust the Laser

Intensity. The picture (figure 4) below shows an example of using wood as the material.
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(Figure 4)
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Part VII XY Plotter

Why the stepper motor doesn’t run or runs abnormal?

1. Make sure it is powered on with 12VDC and power switch is turned on.

2. Check if you have updated firmware. It is required to update firmware whenever switch
mDraw to Benbox and vice versa.
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3. Make sure you have selected the correct serial port. (Here my XY plotter's serial port is COM4,
and you can check your XY Plotter serial port under your computer's Device Manager->Ports
(COM&LPT))
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4. Check the setting on stepper motor driver. When using mDraw, the subdivide should be HHH,
and Benbox requires HLL.
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5. Check wiring of the X-axis and Y-axis. X-axis is connected to Port 1 on Orion board while
Y-axis is connected to Port 2 on Orion board. If necessary, please change the connection and test
how it performs.

6. Check wiring of the stepper motor. It should be in the order of blue, red, green and black

7. It is very important that stepper motor driver should not be directly fixed on the beam, here we
have to use plastic rivet.
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Why I cannot draw correct pictures?

Situation 1: get mirrored picture

Troubleshooting:

1. Make sure the color of the wiring is in correct order (Blue, Red, Green, Black), if not, kindly
change it. If the problem still exists, please exchange the Port1 and Port2 on the main board.

2. In mDraw, please make sure the motor direction is default setting
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Situation 2: wrong size proportion in X-axis and Y-axis

Troubleshooting:
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1. Make sure the timing belt of X-axis and Y-axis are tight.

2. Make sure the headless screws are tightly installed.

3. Make sure the motors driver wiring is correct
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Why it runs abnormal when testing home?

Notes: This FAQ only applies to mDraw and we can only test home in mDraw.

I. It doesn’t move when test home

This issue is usually caused by Limit switch. We can check its state in mDraw and these are the
steps:

1. Make sure you have done firmware update and then connect the official 12V power adapter.

2. Connect USB from Orion to computer and connect COM in mDraw, then go to setting page as
below picture.

3. Test the four limit switch S1, S2, S3, S4 by pressing and releasing separately, check if the state
goes from 0 to 1. (0 means pressed and 1 means released)

If all limit switches will change from 0 to 1 correcting when testing, please start from the second
point. If one of the limit switch is not working properly as it should be, please try follow
troubleshooting.

1. Check the limit switch to Orion board referring to the below picture:
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Note: It is important to check which slot the limit switch connects:
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2. Check the black and white wire connection on limit switch and the top plug interface is
unplugged.

3. Test limit switch itself in mBlock software: connect Orion in mBlock 3->update
firmware->program below codes and check how the panda says when press and release limit
switch.
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Note: For a working limit switch, it shows 1 when pressed and 0 when unpressed. And do
firmware update for the main board before running the codes.

II. It always clash with boundary when test home

1. The limit switch only works when press home, I mean it helps to locate instead of help to
avoid running into the edge;

2. Make sure the limit switch connection is correct:
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Why the laser doesn’t light on or it is weak?

1. Laser should be connected to M2 (orange);

2. In the App, power on laser, if it is normal, M2 led light will be on; if it is not, try to update
firmware again;

3. Change the positive and negative cable connection of M2 and test again;

4. Test Laser separately by connect 12V power to the laser directly as below steps:

i .Plug the power adapter (12V/2A) into a working AC wall outlet.

ii. Put laser’s black and red wires metallic parts to touch the DC connector.
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iii . Red in, black out.

Only put red wire metallic part inside of the DC connector interface, the laser is
off. Then make the black wire metallic part touch the interface metal outside,
check if the laser turns on.
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Note: Do not connect laser directly to 12V for a long time.
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Why the laser cut discontinued lines?

1. Make sure it focuses correctly and generates the lightest laser;

2. Make sure the material is absolutely flat;

3. Make sure M2 connection is tightly connected.
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Why Pen-up and Pen-down is not working properly?

1. Try to update firmware again;

2. Check the Pen servo is connected to RJ25 adapter slot 2;

3. Test Pen up and Pen down: click pen up, pen should be remove from paper and click on pen
down, pen should just get in touch with paper;

4. If the servo works ok but pen up or pen down is not working properly, please re-assemble this
part.
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What I should pay attention when switch from mDraw to

Benbox?

1. Update firmware. Every time we switch from mDraw to Benbox, we need to do firmware
update in the later software;

2. Adjust the subdivision. When use mDraw, it should be HHH, and it should be HLL for Benbox.

3. Adjust pen-up and pen-down parameters (introduced in the product manuals).
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